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PRTK Overview - Interface

Manage Profiles...

\

Dictionary Tools...

@ AccessData Password Recnuerj,r*gulkit 6.4

: — =
 —

File Edit View Tools Help

®

= 0 o a\l"‘ o

View Al Properties
] Job Information
Iename SRR Sl E Attack Type: Microsoft Waord 972000 Passwaord Attack
‘B encrypted file  Microsoft Word 972000 Password Attack Paused | Madule: Micrasaft OFfice Encryption Module
@ encrypted file | Microsoft Ward 97/2000 Decryption Key Atkack Waiting > Prafile: English
Skakus: Paused
Difficulty: Difficult
Beqin Time: 5/04/10 14:38:21
] . ] End Time: -[-/- -:-:-
Right or double click to get more properties Timeout aftert No TimeaL
. . . Decrypkable: Yes
and information about the recovery job .

Note! May need to be started as admin

Dongle Required for lob

,  Dongle required to run job. Only ZIP, PGP, and
; &, PDPCisk jobs may run without a dongle.

Lo ]I

Cancel

F.ilE Information
encrypted File.dac

Ward

97/2000

1337344

71d49072af0685dfc26d372c3cf0b322

90f6bcf3ef48cF3d0def480c078f 1931 5282d359

Unkmiown

9/03/07 4:15:19




PRTK Overview - Modules

¥ User Guide...
Online Support

Recovery Modules
About PRTK

Help > User Guide...
F1 - Very good!

Module Name

Display Name

Attack Types

Supported Products

Arcess

WS Access Password Module

dectryption

Froduct Mame: Microsoft Access
Versions supported:

LUnknown

ACT

ACT! Password Module

decryption

Froduct Mame: ACTI

Versions supported:

2000
5-8

AT Password Module

dictionary

Product Wame: AOL Instant Messenger
Versions supported:

Through 5.5

AmiPro

AmiPro Password Module

dictionary

Froduct Mame: Ami Pro
Versions supported:

LUnknown

ACL

ACL Password Module

keyspace
decryption

Product Mame: AOL

Versions supported:

20-3.0

Recovery Modules

RM listing is also
available
in the user guide

A 4

Approach

Lotus Approach Password MWodule

decryption

Product Mame: Lotus Approach

Versions mpported:

Threugh 97

ART Password Module

dictisnaty
keyspace

Product Mame: ARJ

Versions supported:

Theough 282

Ascend

Ascend Password Module

decryption

FProduct Mame: Ascend
Versions supported:

Unimown

EBeatCrypt

EBeatCrypt Password Iodule

dictionary

Froduct Mame: BestCrypt

Versions supported:

4x-Tx

GoesontoZ ... ~ 110 modules




Starting a Session

Add files via

Menu, Add Files...
Drag and drop or
DropFolder

File| Edit View Tools Help
Mew Case... Ctrl +Skift+M
Delete Case Ctrl +Skift+Delete
Add Files... Ctrl +Insert
I Pause All (2] Add Files
[+ Resume All
®  Delete All = T
[ Generate Report.. =t =

‘& encrypted file.doc
| My speech[decrypted] .t

Exit

Job Name

| [l
b !encrypted file:

C:\hjo\ACE_certification\ace-test|encrypted file.doc

Cancel

r@ Add Job Wizard (Page 2 of 2) . [ ' k 5

File Types
Word: 972000

Files

C:\hjo\ACE_certification|ace-test|encrypted file.doc

Microsoft Word 97,2000 Password Attack (dictionary)
Performs a dictionary attack on the password used to encrypt a Microsoft
Office 97/2000 document.

Microsoft Word 97,/2000 Decryption Key Attack (keyspace)
Performs a keyspace attack on the key used to encrypt a Microsoft Office

97,/2000 document. This key will be unique to the file, and cannot be used
to decrypt other Microsoft Office files.

Microsoft Word 97,2000 Password Key Attack (keyspace)
< | i

Save File Type Defaults
e




Setup Options

4. AccessData Dictionary Ukility =10 x|
Dictionary Tools  Texk Tools  Help

Standard Dictionary Generator

Select a source file: Edit and Import
Ium Files\AccessDatalPRTE &Dictionaries\Your Case Index.kxt Brovese, ., |
More Settings DlCtlonarleS

Generate (21 profile: PRTE x|
Diescription Languages Character Groups
Marne ™ Arabic ™ 7Bt
|Put your profile name here v English [~ &Eit
Comments [ French W Digits
Lewels in this profile are ordered by research conducted on r German [¥ Lowercase Letters
recovered passwords, Each level completes in 24 hours o [] Italian [ Uppercase Letters
less based on a job processing 200,000 passwords f second, | || Russian [V Diactitics
[~ Spanish [+ Symbols {Skandard)
[~ Symbols (Extended)
Dictionaries Rules
Description [ (BAS-1-01) One digit search a
™ [AR-1] Mames-ar . [+ (BAS-1-07) Four digit search
™ [4R-2] Quran-ar IV (Bas-1-03) Two digit search
[ [4R-3] General-ar [ (BAS-2-17) Dictionary primary search
I [DE-1] General-1-de [v (BA5-1-02) One letter, language spedific search
I [DE-1] Gereral-2-de ¥ (BAS-1-05) Three digit search
I [DE-1] General-3-de [w (aDv-1-01% &ll one-characker, language-specific search
I [DE-1] General-4-de [¥ (BAS-1-04) Two letter, language specific search
¥ [EN-1] Common-an [v (B&5-2-23) Dickionary primary Followed by a one digit search
W [EN-2] Miscellaneaus-en ¥ (BAS-1-03) Five digit search
¥ [EN-3] Mames-gn L [ (aDY-1-02) &ll bwa characker, language-specific search
% [EN-4] General-1-en W (BAS-1-06) Three letker, lanquage specific search
Setu p [ [EN-4] Generak-2-en ¥ (BAS-1-10) Six digit search
I [E5-1] General-es W (BAS-2-01) Four letter, language specific search
" ' ™ [FR-1] General-fr [w (ADY-1-03) All three-character, language-specific search _|L|
P rOfI Ies [ [17-11 General-it id| || K r




Importing a new dictionary

Add new dictionaries (from your word lists)
e Full-text index from FTK
e Other user-created text file

i AccessData Dictionary Utility - | Ellil
Dictionary Tools  Text Tools  Help
Standard Dictionary Generator
Select a source file:
Ium FilestAccessDatal PRTE elDickionariesi¥our Case Index,txt I Browse, ., I
Mare Settings
File Edik  “iew | Tools  Help _—-—*
& Dictionary Tools. .. 8-> r’?\‘. I Generate I
@ | = = B o—| | &/
view &l |
Filenarme I Attack Type I Dictionary Tools| Help
Dictionary Browser...
Dicticnary Info...
Biographical Dictionary Generator...
” : ” Pasz-phrase Dictionary Generator...
More Settings” button depends P v
.. . Permutation Dictionary Generator...
on dICtlonary type’ COﬂtaInS Standard Dictionary Generator...
- DICtIOI’]aI’y SettlngS Merge Golden Dictionaries...
- Word Settings




Importing a new dictionary

B3 AccessData Dictionary Import Utility i ]

Dictionary Toals  Help

|5 dictionaries w "_ﬁ
Mame Type | ‘Word Count Modification Date
I GoldenDickionaty il GDYA.. Jun 20, 2009 2 A
'm’ LaE-1] Marmes-ar-C, adr HUF 2l npr <L, HUE 202 M
=) [AR-1] Hames-ar-u.adf aDF  [3071 Apr 2, 2009 4:0 PM
|le=h) [AR-2] Guran-ar-c.adf ADF (18302 Apr 2, 2009 4:0 PM
[l [8R-2] Quran-ar-u. adf ADF  [19551 Apr 2, 2009 4:0 FM
[lE=]) [4R-3] Generak-ar-c.adf ADF 412379 Apr 2, 2009 4:0 FM
|l [8R-3] General-ar-u.adf ADF 439779 Apr 2, 2009 3:59 PM
|l [oE-1] General-1-de-c.adf ADF  [398610 Apr 2, 2009 4:0 FM
|| [DE-1] Seneral-1-de-u.adf ADF  [387247 Apr 2, 2009 4:0 FM
|IE=] [DE-1] General-z-de-c.adf ADF 399635 Apr 2, 2009 4:0 FM
||=f) [DE-1] Seneral-2-de-u. adf ADF 387247 Apr 2, 2009 4:0 PM
|l [DE-1] General-3-de-c.adf ADF 396726 apr 2, 2009 4:0 PM Yiew Entries. .. |
|le=f) [DE-1] Seneral-3-de-u. adf ADF  [337247 fpr 2, 2009 4:0 PM Delete Dickionary |
|[e=h) [DE-1] General-4-de-c.adf ADF  [404779 Apr 2, 2009 4:0 P
|le=h) [CE-1] General-4-de-u. adf ADF 387245 apr 2, 2009 4:0 PM
[|e=h) [Er-1] Comman-en-c.adf ADF 5677 apr 2, 2009 4:0 PM
||=h [Er-1] Common-en-u. adf ADF 5677 apr 2, 2009 4:0 PM
[[e=h) [EM-2] Miscellaneous-en-c.adf ADF 27460 apr 2, 2009 3:59 PM 1=
=) [Er-2] Miscellaneaus-sn-u. adf ADF 27462 apr 2, 2009 4:0 PM
[ [Er-3] Names-en-c.adf ADF 373353 apr 2, 2009 4:0 FM
=) [Er-3] Mames-en-u. adf ADF 373353 apr 2, 2009 4:0 FM
=) [EM-4] General-1-en-c.adf ADF 335715 apr 2, 2009 4:0 FM
=) [Er-4] General-1-en-u.adf ADF 335727 apr 2, 2009 3159 PM
|lE=h) [EM-4] General-z-en-c.adf ADF 335715 apr 2, 2009 4:0 FM
=) [EM-4] General-z-en-u. adf aDF  [335726 apr 2, 2009 4:0 PM
[le=f) [E5-1] Gereral-es-c.adf ADF  [383021 apr 2, 2009 4:0 PM
|l [E5-1] General-es-u. adf ADF  [370470 apr 2, 2009 4:0 PM
=) [FR-1] General-fr-c. adf aDF  [159860 Apr 2, 2009 4:0 PM |
| o= pr———r T " e lammro- A e a o

Windows Vista/7
C:\ProgramData\AccessData\PR\dictionaries



Importing a new dictionary

£ AccessData Dictio nary Utility

Dictionary Tools  Text Tools  Help

Dictionary Browser

° COdepage (-C) and [C3) Dictionaries v
U N iCOd e ( -U ) s PR .T?'j.iﬁf‘a_tih

7| commands-en-c,adf ADF |Ma}.-' 9, 20C
7| commands-en-c.adf. 1 ADF IMa}.-' q, 20C
7| commands-en-c,adf, 2 ADF IMay q, 200
7| commands-en-u,adf ADF IMay q, 200
- - - = commands-en-u.adf, 1 ADF | CEENE
. La rg e d I Ctl O n a rI e S = commands-gn-u,adf. 2 ADF Many 9, 200
% rgkthgf-en-c, adf ADF May 9, 200
%1 Fgthgf-en-u. adf ADF May 9, 20C
S e m e n t e d a t = Fgthgf. il GDfAS-IS  |May 9, 200
g 7| Fgthofz-en-c.adf ADF May 3, 200
| FgthofZ-en-u.adf ADF May 9, 200
5 O O O O O d = Fgthafz.xml GOfASIS  |May 9, 200
J W O r S 7| Goldenbictionary . xml GDfas-13  Maw 19, 20
| PSA BC-en-c,adf ADF May 16, 2C
=l PSA BC-en-u,adf ADF May 16, 2C
I vour Case Index-sn-c, adF ADF Tun 3, 200
=i vour Case Index-en-u, adf ADF un 3, 200
i [iLa = S— TP

>




Biographical Dictionary

EnccessData Dictionary Import Utility

Dictionary Tools  Help

Dickionary Browsetr, .,

Dickionary Infa...

Pass-phrase Dickionary Generator, ..

Permutation Dickionary Generakor. .,

Standard Dickionary Generatar, .,

Y eb-content Dictionary Generatar. ..,

=13l x|

Standard Dictiohary Generator

ect 3 source File:

Merge Golden Dictionaries. ..

More Setkings

Generake

Browse, .. |




Biographical Dictionary

nccessData Dictionary Import Utility

Dictionary Toals  Help

Eiographical Di-::tionary' Geanerator
Biographical Datall Generator

123 Main Street <Address=

Houskon  =City >

Texas «<State=

T =3State>

77002 <Zip Codex 1=
S < Counkry >

58 <Counkry >

nited States <Country= LI

e Add words by category
e Consider case sensitive issues

e Consider concatenating

e Generate when complete




Biographical Dictionary

The 14 entries generated almost 16,000 words in the dictionary!

£ AccessData Dictio nary Utility

Dictionary Tools  Text Tools  Help

Results In:

AccessData Dictionary Import Ukility o C O d e p a g e

Dictiehary Browser o U I"I |C0d e
I dictionaries o X M L (AS - I S )

Marme Type | ‘Word Count Modification Dake

| [DE-1] General-4-de-u, adf aDF  [387245 Apr 2, 2009 4:0 PM
=) [EN-1] Camman-sn-c.adf ADF  [5677 Apr 2, 2009 ¢:0 PM
=) [En-1] Camman-sn-u. adf ADF  [5677 Apr 2, 2009 ¢:0 PM
=) [EN-2] Miscellaneaus-en-c. adf ADF  |27460 Apr 2, 2009 3:59 PM Generating biographical dictionaries. .
=) [EN-2] Miscellaneaus-en-u.adf ADF 27462 Apr 2, 2009 ¢:0 PM
=) [E-3] Mames-en-c.adf ADF (373353 Apr 2, 2009 4:0 PM [ [ |
| [EM-3] Mames-an-u,adf ADF 373353 Apr 2, 2009 4:0 PM Processing biographical data. ..
=) [EN-4] General-1-en-c.adf ADF (335715 Apr 2, 2009 ¢:0 PM
=) [EN-4] General-1-en-u.adf ADF 335727 Apr 2, 2009 3:59 PM
=) [EN-4] General-2-en-c.adf ADF  [335715 Apt 2, 2009 4:0 PM

= [EM-4] General-2-en-u.adf ADF 335726 Apr 2, 2009 4:0 PM

@ [en] Mick-en-c.adf 5325 Jun 20, 2009 3:31 PM

@ [en] Mick-en-u.adf ADF  |15825 Jun 20, 2009 3:31 PM
| [ES-1] General-es-c.adf ADF  [383021 Apr 2, 2009 4:0 PM




Other dictionaries & Golden Dictionary

Permutation Dictionary
— Builds dictionaries by using permutations of

words from a word list file

* Pass-phrase Dictionary
— Builds dictionaries from a phrase file

Attack Level
GoldenDictionary.xml =

Windows Vista/7
C:\ProgramData\AccessData\PR\dictionaries




Setting Up a New Profile

Set up a customized profile to dictate how
PRTK attacks the encrypted file

|E|:|iI: Wiews  Tools  Help

[ Manage Profiles x|

Fules. ., iZkrl+Shift+R.
M, Profiles... Chrl+Shift+P
Select all Chrl-+0
E_§| Preferences. .. Ckrl+P

Metwark License Information. ..

Anvand PRTK profile och
New from selected...

Lagg till eventuellt eget
dictionary fran word list
Spara din nya profil

Nu ar det svart att misslyckas!

A abic
English (default)

Mlew, ..

Mew Fraom selected. .,
mport Edit...
Fass Phrase
PRTE Celete
RLissian
Wordlist Irnport Set as default

E —

BAS-2-17 Dictionary primary search



Setting Up a New Profile

Z profile: untitled

Description Larnguages Character Groups

Marme [+ 7 Eit -
juntitled ¥ S Bit

Cormments [V Digits

[+ Lowercase Letkers

="our comments heres
I+ Uppercase Letkers

I~ Russian [+ Diacritics
[T spanish [+ sSwmbaols (Standard)
[+ Swmbaols (Extended) -

Dictionaries FLles

Diescription I v (B&S-1-01) One digit search -

Jick. =l - [+ (BAS-1-02) One letter, language specific search
AR-1] Mames-ar — [+ (B&s-1-03) Twa digit search
AR-2] Quran-ar [+ (B&s-1-04) Twa letker, language specific search
£F-3] General-ar [+ (BAS-1-057 Thres digit search
DE-1] General-1-de [+ (BAS-1-0&87 Three letker, language specific search
[+ (B&s-1-07) Four digit search
[+ (B&s-1-08) Five digit search
[+ (BAS-1-097 Five Markoy charackers within a threshold of one hundred with |
[+ (BAS-1-100 Six digit search

minin

DE-1] General-2-de
DE-1] General-3-de
DE-1] General-4-de

EM-1] Common-en b
EN-2] Miscellaneaus-en [+ (BAS-1-117% Four Markow characters with a threshold of one primmary search

EN-3] Mames-en [+ (B&s-2-01) Four letker, language specific search

EMN-4] General-1-en [+ (B&s-2-02) Five letter, language specific search

[+ (BAS-2-03) Five Markow charackers with a threshold of one prirnary search
[+ (B&5S-2-04) Five Markow charackers with a threshold of one primary reverse ™

Rl >
3

2 eneral-2-en
-&n

EREEERRRER

-




The New Profile

Zl profile: untitled =]

Description Languages Character Groups
Mame ™ arabic I+~ 7 Eit =
Juntitled I+~ English I+ = Bit
e — I French [+ Digits
oL Comments hiere = [ SEerman v Lowercase Letkers

I~ Italian W Uppercase Letters

T Russian [+ Diacritics

[ Spanish [+ Swmbols (Standard) |

v Swmbols (Extended) -

Dictioraries RLles
Description I+ (BAS-1-01) One digik search =
I Mick.xml - [+ [(BAS-1-02) One letker, language specific search

— [+ (BAS-1-03) Tweo digik search
W (BAS-1-04) Twa letker, language specific search

I [AR-1] Mames-ar
I [aR-2] Quran-ar

I [&R-3] General-ar I+ (BAS-1-05) Three digit search

[~ [DE-1] General-1-de [+ (Bas-1-06) Three letter, language specific search
I [DE-1] General-2-de I+ (EAS-1-07) Four digit search

I~ [DE-1] General--de I+ (B&AS-1-08) Five digik search

[~ [DE-1] General-4-de W (BAS-1-09) Five Markaw charackers within a threshaold of one hundred with |

¥ [EM-1] Common-en |- [+ (BAas-1-10% Six digik search
% [EM-2] Miscellaneous-en W (BAS-1-113 Four Markow charackers wikth a threshold of one prirmary search

= [EM-3] Mames-en [+ [(B&as-2-01) Four letker, languages specific search

[+ [EM-4] General-1-gn [+ [(BAS-2-02) Five letter, language specific search

[+ [EM-4] General-Z-en [+ (BAS-2-03) Five Markow charackers with a threshold of one primary search
[+ [en] Mick-en v (BAS-2-04) Five Markow charackers with a threshold of one primary reverse ™
F e 471 = e e e ;I ll

3
| I
Select all Select Mone Select all Select Mone

e Rules are ordered smallest to largest

e All English dictionaries selected by default




The Default Profile (English

grmeeen I ==

Description Languages Character Groups

Mame [ arabic [ 7Eit -

English| English ] &Eit T N t

Comments [] French Diigits ® O C U S O I I l
[] German Lowercase Letters |

The English profile begins by searching for simple

passwords, followed by, dictionary and permutated |§| [E] ttalian Uppercase Letters |~ d I Ctl O n a rl es

dictionary searches, and ends with complex searches for | Russian Diadritics
dictionary and computed password. All default English [”] Spanish Symbels (Standard)
i s p ) -

I dirtinnariar and charctar cobe ara ocad

Dictnares — e Not efficient!

Description | Qrder (BAS-3-08) Lowercases words from selected dictionaries -
(BAS-3-09) Lowercases words from selected dictionaries followed by a |E|
{BA5-1-01) One digit search TR
{BAS-1-03) Two digit search
(BAS5-1-05) Three digit search
{BAS-1-07) Four digit search
(BAS-1-08) Five digit search
(BAS-1-02) One letter, language spedific search
[¥] (BAS-1-04) Two letter, language specific search
(BAS-1-08) Three letter, language specific search
(ADV-1-01) All one-character, language-specific search
(ADY-1-02) All two character, language-specific search
(BAS-1-11) Four Markov characters with a threshold of one primary sez
(BAS-2-03) Five Markov characters with a threshold of one primary sea -

[ [aR-1] Mames-ar
[ [AR-2] Quran-ar

I [] [AR-3] General-ar
[ [DE-1] General-1-de
[ [DE-1] General-2-de
[ [DE-1] General-3-de
[] [DE-1] General-4-de
[EM-1] Common-en
[EM-2] Miscellaneous-en
[EM-3] Mames-en
[EM-4] General-1-en
[EM-4] General-2-en

[ [en] ace_wl-en

| »

m

- 1 |

3

This was designed for the untrained user!



The PRTK profile

2] profile: PRTK x|

Descintn Languiges SRR e Based on 1,000,000-
Marne [~ arabic [~ 7 Bit = 4 I
FRTK [ English [ =Bt
password stud
Lewels in this profile are ordered by research conducted on I Ge:_man V' Lowercase Letters y
recovered passwords, Each level completes in 24 hours or I Italian V' Uppercase Letters
less based on a job processing 200,000 passwords § second. [™ Russian [V Diacricics

[~ Sparish W Symbols (Standard) e

-

™ Swrnhile (Fectandedt

e Rules are ordered for

Description | W (BAS-1-01) Cne digit search A

™ Nickoxml =1 |¥ (BAS-1-07) Four digit search ff T -

™ [AR-1] Mames-ar ¥ (Bi5-1-03) Two digit search = e I C I e n Cy

I [AR-2] Quran-ar | (BAS-2-17) Dictionary primary search

I [AR-3] General-ar ¥ (BAS-1-02) One letter, language specific search

[ [CE-1] Generak-1-de ¥ (BAS-1-05) Three digit search

I [DE-1] General-2-ds W (ADY%-1-01) All one-character, language-specific ssarch =

[~ [DE-1] General-3-de ¥ (BAS-1-04) Twa letter, language specific search . D e S I g n e to C O m p e te
I [DE-1] General-4-da ¥ (BAS-2-23) Dictionary primary followed by & one digit search

[¥ [EN-1] Commen-en ¥ (Bi5-1-08) Five digit search .

[V [EM-2] Miscellaneous-gn v (a0Y-1-023 &ll bwo character, language-specific search I n 1 W e e k O n a V e ra e
¥ [EN-3] Names-en ¥ (BAS-1-08) Three letter, language specific search g

[¥ [EN-4] Generak-i-en ¥ (Bi5-1-10) Sive digit search

[V [EM-4] General-z-en E (BA3-2-01) Four letter, language specific search =

[ len] Mick-en LI 1| | hl

Select Al Select Hone Move Up Ty — Select Al | Select Mone o If u n S u C C e S Sfu I ,
consider DNA

e Use it as a template

e Rename, update dictionary selections,
and save for each new profile

This was designed for the trained user
Make it your default!



User defined rules

Edit > Rules... Create and edit user defined rules

CTTamm e

Rule Mame: EHj.G-tEE’.E.
| rule oefinitiopn —0m——o—w—rorin-oo---——— - - | ' ' _ _ -
" hjo-test
| Characters
“ Concatenate
- .| Dictionary 2
Lower Case I
oz | Markov
Dictionary [[en] Wordlist-lecture-en...
- | Wards —
|
.| Golden Dictionary
.~ Arabic on English Keyboard I
" Arabicize
4, Concatenate

Word Set
Dictionary Characker Groups
1EM-3] Mames-en-c,adf ]

Murmber of Characters m [ ]
Threshold m [

"o ] e )

-



FTK Export Word List...

File > Export Word List...

Exporterar indexerade sOk registret till en fil, alltsa alla
textstrangar funna i caset (kom ihag strangar fran
reqgistry filer!)

Notera var du spar din word list!

Om man lyckats dekryptera nagot dokument etc.

— | FTK kor Evidence > Additional Analysis..., markera foljande
boxar i "Search Indexes” sa de nya textstrangarna kommer med
och merga indexet. Generera en ny word list, uppdatera sedan

d iCtionary | PRTK. Search Indexes
. v dtSearch® Text Index
Snabb word list attack @ Entopy Test |
(don't index compressed or encrypted items)
— Utgé frén FTK WO rd I |St Im pOrt [ Do notindude document metadata in filtered text
mallen i Manage Profiles med P Wi e e e e

"(BAS-3-10) Uses entries 'AS-IS' from
selected dictionaries™. Valj din word list som dictionary.



Anvandarkonto exempel

* Enbart word list dictionary anvands, skall inte ta mer an
nagra minuter maximalt!

 Enbart LAN hash markerad > vad innebar det?

— LAN hash gar snabbt att [reieweusimer ==
knacka med Brute Force! | = —

All 7-Bit Characters (ASCII)
Wordlist Import ace English All 8-Bit Characters
a . Comments French | Uppercase Letters
1 o 1 & .
Module Options [ChUsers\hjot\Desktop\aceh\SAM] I. J Performs o dictionary attack on selected dictionaries, Use asa  » German v L?Ae_r_case Letters
template for imported wordlists. Italian | Diacritics
Module Options Russian /| Digits
- Sparish | Symbols (Standard)
Select a user and password hash version = Symbals (Extended)
[™ NThash i Dictionaries Levels
= -
¥ LAY hash Description - /| Dictionary Search -
Ulysseus -
- . (BAS-1-01) One digit search =
[ NT hash E ] [en] ace_wl_ri-en-.adf _
- 3 7] [en] ace_wi_ri-en-u.adf (EAS-1-02) One letter, language specdific search
[¥ LA hash - == '

(BAS-1-03) Two digit search
(BAS-1-04) Two letter, language specific search
Enter a file with the startkey information for this SAM file. The (BAS-1-05) Three digit search
sta_rtkey is u.';ua]ly found in the ﬁle_ca]led "SYSTEM' IDCR-th in [FR-1] General-fr-u.adF {BAS-1-08) Three letter, language spedific search
Eﬁ;ﬁ?ﬁsiﬁeﬁﬁf c I T s [IT-1] General-t.adf E:igiﬂ;; Four dat search

git search

- | -1] General-it-u.adf
|CZ'!USEI’S‘thJD‘tDES|'CtDP\ECE [rr-1] (BAS-1-03) Five Markov characters within a threshold of one hundred with t

g 5 q oA JA-1] Hi “Ja-c.adf
In rare cases the startkey is not contained in any file and is instead La-1] !ragana J_a{ 2 (BAS-1-10) Six digit search
derived from a hrase. If you know the hrase, enter it here: [3A-1] Hiragana-ja-u.adf i i
passp ALy passp s ' (BAS-1-11) Four Markov characters with a threshold of one primary search

[1A-2] Kanji-ja-c.adf
| [14-2] Kanji<a-u.adf (BAS-2-01) Four letter, language specdific search

[ES-1] General-es-c.adf
[E5-1] General-es-u.adf
[FR-1] General-fr-c.adf

m

m

e e e I e (AL 2 [14-3] Katakana-a-c.adf {BAS-2-02) Five letter, language spedific search 52
F18 91 odolommn im oo odE & 4 LLLJ k
3 ] | Emel ove Up ove Do Deselect Al

oK ]| Cancel |

e [




Possible PRTK attacks

Decryption Attack
— Decrypts the password that locks the file

Dictionary Attack

— Uses the words in a dictionary, applies rules to the words, and applies
the password to the files or converts the possible words into keys
Keyspace Attack

— Tries every possible key because there is a finite number of keys for
the file

— The possible number of keys can be very large, therfore used on
applications that use 40-bit encryption or less

Reset Attack

— Rewrites the key that opens the file to a key that comes from a
password that you specify. Few applications are susceptible to it.

Multiple Attacks

— Some applications are susceptible to more than one attack type which
can decrease the time necessary to decrypt a file. PRTK starts with
the least time-consuming attack type.



Bit Strength Classification

Key: Any One of a Larger Number of Values

Keyspace: Range of Possible Values (this can get big!)
1 2
2 4
Easy 3 )
4 16
5} 32
Moderate 6 64
7 128
8 256
1FF: 9 512
Difficult o ey
20 1048 576
30 1073 741 824
DNA !l 32 4204 967 296
33 8 589 934 592
40 1099 511 627 776
&0/0@ # 111 50 1125 899 906 842 620

Check out the keyspace password.xls file



Break MS DPAPI (Data Protection
Application Programming Interface)

DPAPI is built in Windows since Win2K

— http://en.wikipedia.org/wiki/Data_Protection_API

DPAPI (Vista/IE7 and up) is the successor of the legacy PSSP (Protected
Storage System Provider) which store (below) and moved to IntelliForms key

— Form data, Web search queries, Web passwords and Outlook/Express passwords

(PSSP are on the fly decrypted by RV)
— Storage1 - queries and form data

— Storage?2 - login password info

[=&""] IntelliForms + | Mame
- (O storagel &% PSMigrated
P ® - 5tu:urage2 - |[B¥ AskUser

MTUSER.DATSoftware\Microsoft\Internet Explorer\IntelliForms

To break DPAPI protected data we need: user logon password, users protect

folder and information specific below

— For URL logon pages: the address of the page accessed

— For search terms: the query engine header

— For form data: the field name of the form field used

— The AccessData PDF “Decrypting IntelliForms” have instructions performing the
DPAPI information decryption with PRTK at their support web

DPAPI programming example with a C++ wrapper class

— http://www.codeproject.com/KB/system/protected data.aspx



FILE ENCRYPTION

Symmetric Key (FEK)

File Encryption Encrypted File \

Windows EFS
(Encrypting File
System) operation

[
y
[

: =
In short =
FEK User's Public Key —
~ File Encryption Key - new = A o,
random one for every file O=——— > m>
— Stored in an ADS, the Encryption Encrypted FEK
$Logged Utility Stream
attribute in MFT FILE DECRYPTION
- Marked as $EFS |n FTK m;, User's Private Key
Transparent for apps - QP
(Windows API) — > _b- —

Encrypted File Encrypted FEK Decryption

i O—
Decrypted if copied/moved  vinFekinheader
outside NTFS or over the \

network

Vista/7 supports storage of
private key on smart card

il
i)
Ll

Encrypted File Decryption File



EFS and FTK

When PRTK has obtained the Iogln password, use Tools > Decrypt Files...

I:I@i:h

ﬂ AccessData Forensic Toolkit Versien: 4.0.1.35151 Database: localhost Case: precious -Education-

File Edit View Evidence Fiter Tools Manage Help
Filter: = -unfiltered - - Filter Manager... . @
Explore | Overview Ermail | Graphics |Bookmarks | Live Search |Index Search Volatile 4 b
Evidence Items 4 I File Content
- () Local Settings ~ | Hex | Text | Fitered | Natural
F- ) My Documents o [w)
) fielb &
& ¥ Great Pidwp Lines.doc 'f' L - ol (=
5@ QU EFS Certificate List -
----- D Mortgage accounting inc escrow, %
[+ | MSN File Sharing - =
B+ |E] My Buddies.doc version 2 g
----- IC5) My Buddy Lists
M- #® My Love.doc E ; .
_____ =) My Music Decryption Agent Certificate L
B I My Pictures User Frodo Baggins{Frodo Baggins@FRODO1)
B~ 5 My Received Files . . .
-2 [©) Passwords and Stuff.doc Issuer Microsoft Base Cryptographic Provider v1.0
M- Passwords.doc Serial 4893d62d-3706-4fa3-ae73-7ed10382000b
- T PGP Number
""" () Retire Scenario Adjustable for Te Thumbprint d471 7791 e133 675d d75b 2ca4 6132 63ad e353 226 .
-1 T Super Secret o
o [£7) Thumbs.db i
4 Tl 3 File Content Properties Hex Interpreter
File List
Iﬂ . =. . -|f=- = ﬁ Normal - Display Time Zone: W. Europe Daylight Time (From local machine) & S
| « Name |Label  [remz | Ext | Path | category | P-size [L-Size | MDS | sa1 [ sHazs6 | created
% sers 2993 precious. E01/Partition 1... EFSFE... 1024B 568 B 14C30... BFD71.. AF920... 2005-01
[[J= Decrypted copy of Great Pickup Lines.doc 8003 doc precious,E01/Partiion 1... Microso.,, 22,00KB  22,00KB  239160,.. 330567... 1FAG9...  2005-01
|
4 L I
| Loaded: 2 | Filtered: 2 | Total: 2 | Highlighted: 1 | Checked: 0 | Total L5ize: 22,55 KB
precious.E01/Partition 1/ The Precious [NTFS]/[root]/Documents and Settings/Frodo Baggins/My Documents/Great Pickup Lines.doc/$EFS
Ready Explore Tah Filter: [Mone]




PRTK new functions

* Accelerating Password Recovery using GPU Hardware

— PRTK will automatically detect if GPU acceleration is possible and will
utilize the hardware as necessary. No additional steps are
required.

— Using GPU acceleration is transparent on the computer. DNA
and PRTK utilize the supported hardware if it is available. In
the absence of such hardware, CPUs will continue to be
utilized to their greatest capacity.

* Supports

— List of jobs that can be run with GPU — see the manual
— Nvidia CUDA GPUs



